# Table of Contents

- Microsoft Excel Interface ................................................................. 3
- Menu Bar .......................................................................................... 3
- Standard Toolbar and Formatting Toolbar ....................................... 3
- Formula Bar ...................................................................................... 4
- Status Bar .......................................................................................... 4
- Selecting a Cell ................................................................................ 5
- Entering Text .................................................................................... 5
  - To Enter the Worksheet Title ....................................................... 6
  - AutoCorrect ................................................................................... 7
- Entering Column Titles ................................................................. 7
- To Enter Row Titles ......................................................................... 9
- To Enter Numeric Data ................................................................... 10
- Calculating a Sum ........................................................................... 11
  - To Sum a Column of Numbers .................................................... 11
  - To Copy a Cell to Adjacent Cells in a Row ................................. 13
  - To Determine Multiple Row Totals at the Same Time ............... 14
- Formatting the Worksheet ............................................................. 15
  - To Bold a Cell .............................................................................. 15
  - To Increase the Font Size of a Cell Entry ................................. 16
  - Using AutoFormat to Format the Body of a Worksheet .......... 17
  - To Use AutoFormat to Format the Body of a Worksheet .......... 17
- Centering the Worksheet Title Across Columns ............................ 19
- Using the Name Box to Select a Cell ........................................... 20
  - To Use the Name Box to Select a Cell ....................................... 20
  - To Add a 3-D Column Chart to the Worksheet ......................... 21
  - To Save a Workbook ................................................................... 24
- AutoCalculate .................................................................................. 26
  - To Use the AutoCalculate Area to Determine an Average ....... 26
- Correcting Errors While You Are Typing Data into a Cell .......... 27
- In Cell Editing .................................................................................. 27
- Clearing a Cell or Range of Cells .................................................. 28
  - To Clear Cell Contents Using the Fill Handle .......................... 28
  - To Clear Cell Contents Using the Shortcut Menu ...................... 28
  - To Clear Cell Contents Using the Delete Key ............................. 28
  - To Clear Cell Contents Using the Clear Command .................... 28
  - To Clear the Entire Worksheet ................................................... 28
  - To Delete an Embedded Chart ..................................................... 28
Microsoft Excel Interface

Menu Bar
The menu bar is a special toolbar which displays a menu, such as the file and Edit menus.

Standard Toolbar and Formatting Toolbar
The Standard toolbar and the Formatting toolbar (Figure I-8b) contain buttons and list boxes that allow you to perform frequent tasks more quickly than when using the menu bar. When you move the mouse pointer over a button or box, the name of the button or box displays below it in a ScreenTip.

Both the Standard and Formatting toolbars are preset to display on the same row, immediately below the menu bar. To display the entire Standard toolbar, double-click the move handle on the left. Excel slides the Formatting toolbar to the right so the toolbars appear as shown previously.

An alternative to sliding one toolbar over another is to use the More Buttons button on a toolbar to display the buttons that are hidden.

As with the menus, Excel will personalize the toolbars. That is, if you use a hidden button on a partially displayed toolbar, Excel will remove the button from the More Buttons list and place it on the toolbar.
Formula Bar
Below the Standard and Formatting toolbars is the formula bar. As you type, the data displays in the formula bar. Excel also displays the active cell reference on the left side of the formula bar in the Name box.

Status Bar
Immediately above the Windows taskbar at the bottom of the screen is the status bar. The status bar displays a brief description of the command selected (highlighted) in a menu, the function of the button the mouse pointer is pointing to, or the current activity in progress. Mode indicators, such as Enter and Ready, display on the status bar and specify the current mode of Excel. When the mode is Ready, Excel is ready to accept the next command or data entry. When the mode indicator reads Enter, Excel is in the process of accepting data through the keyboard into the active cell.

In the middle of the status bar is the AutoCalculate area. The AutoCalculate area can be used in place of a calculator to view the sum, average, or other types of totals of a group of numbers on the worksheet.

Keyboard indicators, such as NUM (Num Lock), CAPS (Caps Lock), and SCRL (Scroll) show which keys are used.
Selecting a Cell
To enter data into a cell, you first must select it. The easiest way to select a cell (make it active) is to use the mouse pointer to the cell and then click.

An alternative method is to use the arrow keys that are located just to the right of the typewriter keys on the keyboard. An arrow key selects the cell adjacent to the active cell in the direction of the arrow on the key.

You know a cell is selected (active) when a heavy border surrounds the cell and the active cell reference displays in the Name box on the left side of the formula bar.

Entering Text
In Excel, any set of characters containing a letter, hyphen (as in a telephone number), or space is considered as text. Text is used to place titles on the worksheet, such as worksheet titles, column titles, and row titles. In Project 1, the worksheet title, Fun-N-Sun Sojourn 1st Qtr Sales, identifies the worksheet.

The column titles in row 2 (Mail, Campus, Telephone, Web, and Total) identify the data in each column. The row titles in column A (Bahamas Repose, Daytona Delight, Key West Haven, South Padre Del Sol, and Total) identify the data in each row.
To Enter the Worksheet Title

1. Click cell A1. Cell A1 becomes the active cell and a heavy border surrounds it.

2. Type Fun-N-Sun Sojourn 1st Qtr Sales in cell A1. The title displays in the formula bar and in cell A1. The text in cell A1 is followed by the insertion point. The insert/on point is a blinking vertical line that indicates where the next character typed will display.

3. Point to the Enter box. When you begin typing an entry, Excel displays two boxes in the formula bar: the Cancel box and the Enter box.
Click the Enter box to complete the entry. Excel enters the worksheet title in cell A1.

Note
- Excel positions the text left-aligned in the cell
- When the text is longer than the width of a column, Excel displays the overflow characters in closest cells to the right as long as these close cells contain no data
- When you complete an entry by clicking the Enter box, the cell in which the text is entered remains the active cell

AutoCorrect
The AutoCorrect feature of Excel works behind the scenes, correcting common mistakes when you complete a text entry in a cell. AutoCorrect makes three types of corrections for you:
1. Corrects two initial capital letters by changing the second letter to lowercase.
2. Capitalizes the first letter in the names of days.
3. Replaces commonly misspelled words with their correct spelling. AutoCorrect will correct the spelling automatically of more than 400 commonly misspelled words.

Entering Column Titles
To enter the column titles, select the appropriate cell and then enter the text, as described in the following steps.

3. Press the right arrow key. Excel enters the column title, Mail, in cell B2 and makes cell C2 the active cell.

4. Repeat Steps 2 and 3 for the remaining column titles in row 2. That is, enter Campus in cell C2, Telephone in cell D2, Web in cell E2, and Total in cell F2. Complete the lost entry in cell F2 by pressing the ENTER key.
To Enter Row Titles

1. Click cell A3. Type Bahamas Repose and then press the down arrow key. Excel enters the row title Bahamas Repose in cell A3 and cell A4 becomes the active cell.

2. Repeat Step 1 for the remaining row titles in column A. Enter Daytona Delight in cell A4, Key West Haven in cell A5, South Padre Del Sol in cell A6, and Total in cell A7. The row titles display as shown in.

Note:
- In Excel, text is left-aligned in a cell, unless you change it by realigning it. Excel treats any combination of numbers, spaces, and nonnumeric characters as text. For example, the following entries are text: 401AX21, 921-231, 619 321, 883XTY
- In Excel, you can enter numbers into cells to represent amounts. Numbers can contain only the following characters: 0123456789 + -()/,$%Ee
- If a cell entry contains any other keyboard character (including spaces), Excel interprets the entry as text and treats it accordingly
In Project 1, the Fun-N-Sun first quarter numbers are summarized in the following table.

### Fun-N-Sun First Quarter Data

<table>
<thead>
<tr>
<th>MAIL</th>
<th>CAMPUS</th>
<th>TELEPHONE</th>
<th>WEB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bahamas Repose</td>
<td>52,978.23</td>
<td>38,781.35</td>
<td>37,213.45</td>
</tr>
<tr>
<td>Daytona Delight</td>
<td>28,234.50</td>
<td>48,401.53</td>
<td>27,034.56</td>
</tr>
<tr>
<td>Key West Haven</td>
<td>62,567.25</td>
<td>72,516.12</td>
<td>24,354.86</td>
</tr>
<tr>
<td>South Padre Del Sol</td>
<td>28,567.15</td>
<td>69,777.64</td>
<td>49,976.60</td>
</tr>
</tbody>
</table>

These numbers, which represent first quarter sales for each of the sales channels and vacation packages, must be entered in rows 3, 4, 5, and 6. The following steps show how to enter these values one row at a time.

### To Enter Numeric Data

1. Click cell B3. Type 52978.23 and then press the right arrow key. Excel enters the number 52978.23 in cell B3 and changes the active cell to cell C3. The numbers are formatted with dollar signs and commas later in this project.

2. Enter 38781.35 in cell C3, 37213.45 in cell D3, and 29998.65 in cell E3. Row 3 now contains the first quarter sales by sales channel for the vacation package Bahamas Repose. The numbers in row 3 are right-aligned, which means Excel displays the cell entry to the far right in the cell.
3. Click cell B4. Enter the remaining first quarter sales provided on the previous page in the table by sales channel for each of the three remaining vacation packages in rows 4, 5, and 6. The first quarter sales display as shown below.

Note:
- You are not required to type dollar signs, commas, or trailing zeros. Later in this project, dollar signs, commas, and trailing zeros will be added to improve the appearance of the numbers.

Calculating a Sum
The next step in creating the first quarter sales worksheet is to determine the total first quarter sales by Mail in column B. To calculate this value in cell B7, Excel must add the numbers in cells B3, B4, B5, and B6. Excel's SUM function provides a convenient means to accomplish this task.

To use the SUM function, first you must identify the cell in which the sum will be stored after it is calculated. Then, you can use the AutoSum button on the Standard toolbar to enter the SUM function as shown in the following steps.

To Sum a Column of Numbers
1. Click cell B7 and then point to the AutoSum button on the Standard toolbar. Cell B7 becomes the active cell.
2. Click the AutoSum button. Excel responds by displaying =SUM(B3:B6) in the formula bar and in the active cell B7. The B3:B6 within parentheses following the function name SUM is Excel’s way of identifying the cells B3 through B6. Excel also surrounds the proposed cells to sum with a moving border, called a marquee.

3. Click the AutoSum button a second time. Excel enters the sum of the first quarter sales in cell B7. The SUM function assigned to cell B7 displays in the formula bar when cell B7 is the active cell.

When you enter the SUM function using the AutoSum button, Excel automatically selects what it considers to be your choice of the group of cells to sum. The group of adjacent cells B3, B4, B5, and B6 is called a range. A range is a series of two or more adjacent cells in a column or row or a rectangular group of cells. Many Excel operations, such as summing numbers, take place on a range of cells.

When proposing the range to sum, Excel first looks for a range of cells with numbers above the active cell and then to the left. If Excel proposes the wrong range, you can drag through the correct range anytime prior to clicking the AutoSum button a second time. You also can enter the correct range by typing the beginning cell reference, a colon (:) , and the ending cell reference.
To Copy a Cell to Adjacent Cells in a Row

1. With cell B7 active, point to the fill handle. The mouse pointer changes to a cross hair.

2. Drag the fill handle to select the paste area, range C7:E7. Excel displays a shaded border around the paste area, range C7:E7, and the copy area, cell B7.

3. Release the mouse button. Excel copies the SUM function in cell B7 to the range C7-E7. In addition, Excel calculates the sums and enters the results in cells C7, D7, and E7.
To Determine Multiple Row Totals at the Same Time

1. Click cell F3. Cell F3 becomes the active cell.

2. With the mouse pointer in cell F3 and in the shape of a block plus sign, drag the mouse pointer down to cell F7. Excel highlights the range F3:F7.

3. Click the AutoSum button on the Standard toolbar. Excel assigns the appropriate SUM functions to cell F3, F4, F5, F6, and F7, and then calculates and displays the sums in the respective cells.

4. Select cell A8 to deselect the range F3:F7.

Note:
- You could have selected the range B7:E7 and then clicked the AutoSum button once.
Formatting the Worksheet

To Bold a Cell

1. Click cell A1 and then point to the Bold button on the Formatting toolbar. The ScreenTip displays immediately below the Bold button to identify the function of the button.

2. Click the Bold button. Excel applies a bold format to the worksheet title Fun-N-Sun Sojourn 1st Qtr Sales.
To Increase the Font Size of a Cell Entry

1. With cell A1 selected, click the Font Size box arrow on the Formatting toolbar and then point to 20 in the Font Size list.

2. Click 20. The font size of the characters in the worksheet title in cell A1 increase from 10 point to 20 point.
Using AutoFormat to Format the Body of a Worksheet

Excel has several customized format styles called table formats that allow you to format the body of the worksheet. Using table formats can give your worksheet a professional appearance. Follow these steps to format the range A2:F7 automatically using the AutoFormat command on the Format menu.

To Use AutoFormat to Format the Body of a Worksheet

1. Select cell A2, the upper-left corner cell of the rectangular range to format. Drag the mouse pointer to cell F7, the lower-right corner cell of the range to format. Excel highlights the range to format with a heavy border and blue background.

2. Click Format on the menu bar and then point to AutoFormat. The Format menu displays.
3. Click AutoFormat. Click the Accounting 2 format (column 2, row 3) in the AutoFormat dialog box. Point to the OK button. The AutoFormat dialog box displays with a list of customized formats. Each format illustrates how the body of the worksheet will display if it is chosen.

4. Click the OK button. Select cell A9 to deselect the range A2:F7. Excel displays the worksheet with the range A2:F7 using the customized format, Accounting 2.
MS Excel Tutorial – Project 1

Centering the Worksheet Title Across Columns

With the column widths increased, the final step in formatting the worksheet title is to center it across columns A through F. Centering a worksheet title across the columns used in the body of the worksheet improves the worksheet's appearance.

1. Click cell A1. Drag the block plus sign to the right most cell (F1) of the range to center (A1:F1). Point to the Merge and Center button on the Formatting toolbar. When you drag through the range A1:F1 Excel highlights the cells.

2. Click the Merge and Center button. Excel merges the cells A1 through F1 to create a new cell A1 and centers the contents of cell A1 across columns A through F. After the merge, cells B1 through F1 no longer exist on the worksheet.

3. Click cell A9 to deselect cell A1.
Using the Name Box to Select a Cell

The Name box is located on the left side of the formula bar. To select any cell, click the Name box and enter the cell reference of the cell you want to select. Perform the following steps to select cell A2.

To Use the Name Box to Select a Cell

1. Click the Name box in the formula bar. Type a2 in the Name box. Even though cell A9 is the active cell, the Name box displays the typed cell reference a2.

2. Press the enter key. Excel changes the active cell from cell A9 to cell A2.
To Add a 3-D Column Chart to the Worksheet

1. Double-click the move handle on the left side of the Standard toolbar to display the entire toolbar. With cell A2 selected, position the block plus sign within the cell's border and drag the mouse pointer to the lower-right corner cell (cell E6) of the range to chart (A2:E6). Point to the Chart Wizard button on the Standard toolbar. Excel highlights the range to chart.

2. Click the Chart Wizard button. The Chart Wizard - Step 1 of 4 - Chart Type dialog box displays.

With Column selected in the Chart type list, click the 3-D Column chart sub-type (column 1, row 2) in the Chart sub-type area. Point to the Finish button. Column is highlighted in the Chart type list and Clustered column with a 3-D visual effect is highlighted in the Chat sub-type area.
3. Click the Finish button. Excel draws the 3-D Column chart. The chart displays in the middle of the window in a selection rectangle. The small sizing handles at the corners and along the sides of the selection rectangle indicate the chart is selected.

4. Drag the chart down and to the left to position the upper-left corner of the dotted line rectangle over the upper-left corner of cell A9. Excel displays a dotted line rectangle showing the new chart location. As you drag the selected chart, the mouse pointer changes to a cross hair with four arrowheads.
5. Release the mouse button. Point to the middle sizing handle on the right edge of the selection rectangle. The chart displays in a new location. The mouse pointer changes to a horizontal line with two arrowheads when it points to a sizing handle.

6. While holding down the alt key, drag the sizing handle to the right edge of column F. Release the mouse button. While you drag, the dotted line rectangle shows the new chart location. Holding down the ALT key while you drag a chart snaps (aligns) the new border to the worksheet gridlines.
MS Excel Tutorial – Project 1

7. If necessary, hold down the alt key and drag the lower-middle sizing handle up to the lower edge of row 19. Click cell A21 to deselect the chart. The new chart location extends from the top of cell A9 to the bottom of cell F19.

Note:

- Excel automatically selects the entries in the topmost row of the range (row 2) as the titles for the horizontal axis (also called the x-axis or category axis) and draws a column for each of the 16 cells in the range containing numbers.
- The small box to the right of the column chart in Figure 1-55 contains the legend. The legend identifies each bar in the chart. Excel automatically selects the leftmost column of the range (column A) as titles within the legend. It also automatically scales the y-axis on the basis of the magnitude of the numbers in the chart range.
- Excel offers 14 different chart types. The default chart type is the chart Excel draws if you click the Finish button in the first Chart Wizard dialog box. When you install Excel on a computer, the default chart type is the 2-D (two-dimensional) Column chart.

To Save a Workbook

1. Click the Save button on the Standard toolbar. The Save As dialog box is displayed. The preset Save in folder is My Documents, the preset file name is Book1, and the file type is Microsoft Excel Workbook. The buttons on the top and on the side are used to select folders and change the display of file names and other information.
2. Type Fun-N-Sun Sojourn 1st Qtr Sales in the File name text box. The new file name replaces Book1 in the File name text box. A file name can be up to 255 characters and can include spaces.

3. Click on the drop down list and select Desktop. You can also click on the icon on the left side toolbar of the Save As window.

4. Click the Save button. Although the workbook is saved, it also remains in memory and displays on the screen. Notice the file name in the title bar.
AutoCalculate

You easily can obtain a total, an average, or other information about the numbers in a range by using the AutoCalculate area on the status bar. All you need do is select the range of cells containing the numbers you want to check. Next, right-click the AutoCalculate area to display the shortcut menu. The recessed check mark to the left of the active function (Sum) indicates that the sum of the selected range displays. The function commands on the AutoCalculate shortcut menu are described in the following table.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>Displays the average of the numbers in the selected range</td>
</tr>
<tr>
<td>Count</td>
<td>Displays the number of nonblank cells in the selected range</td>
</tr>
<tr>
<td>Count Nums</td>
<td>Displays the number of cells containing numbers in the selected range</td>
</tr>
<tr>
<td>Max</td>
<td>Displays the highest value in the selected range</td>
</tr>
<tr>
<td>Min</td>
<td>Displays the lowest value in the selected range</td>
</tr>
<tr>
<td>Sum</td>
<td>Displays the sum of the numbers in the selected range</td>
</tr>
</tbody>
</table>

To Use the AutoCalculate Area to Determine an Average

1. Select the range B3:E3. Right-click the AutoCalculate area on the status bar. The sum of the numbers in the range B3:E3 displays ($158,971.68) as shown below because Sum is active in the AutoCalculate area (you may see a total other than the Sum in your AutoCalculate area). The shortcut menu listing the various types of functions displays over the AutoCalculate area.
2. Click Average on the shortcut menu. The average of the numbers in the range B3:E3 displays in the AutoCalculate area.

3. Right-click the AutoCalculate area and then click Sum on the shortcut menu.

Correcting Errors While You Are Typing Data into a Cell
If you notice an error while you are typing data into a cell, press the backspace key to erase the portion in error and then type the correct characters. If the error is a major one, click the Cancel box in the formula bar or press the esc key to erase the entire entry and then reenter the data from the beginning.

In Cell Editing
If you find an error in the worksheet after entering the data, you can correct the error in one of two ways:
1. If the entry is short, select the cell, retype the entry correctly, and click the Enter box or press the ENTER key. The new entry will replace the old entry.
2. If the entry in the cell is long and the errors are minor, the Edit mode may be a better choice. Use the Edit mode as described below.
   a. Double-click the cell containing the error. Excel switches to Edit mode, the active cell contents display in the formula bar, and a flashing insertion point displays in the active cell. This editing procedure is called in-cell editing because you can edit the contents directly in the cell. The active cell contents also display in the formula bar.
b. Make your changes, as specified below.
   I. To insert between two characters, place the insertion point between the two characters and begin typing. Excel inserts the new characters at the location of the insertion point.
   II. To delete a character in the cell, move the insertion point to the left of the character you want to delete and then press the DELETE key, or place the insertion point to the right of the character you want to delete and then press the backspace key. You also can use the mouse to drag through the character or adjacent characters you want to delete and then press the delete key or click the Cut button on the Standard toolbar.
   III. When you are finished editing an entry, click the Enter box or press the enter key.

**Clearing a Cell or Range of Cells**

If you enter data into the wrong cell or range of cells, you can erase, or clear, the data using one of several methods. Never press the spacebar to clear a cell. Pressing the spacebar enters a blank character. A blank character is text and is different from an empty cell, even though the cell may appear empty. Excel provides three methods to clear the contents of a cell or a range of cells.

**To Clear Cell Contents Using the Fill Handle**

1. Select the cell or range of cells and point to the fill handle so the mouse pointer changes to a cross hair.
2. Drag the fill handle back into the selected cell or range until a shadow covers the cell or cells you want to erase. Release the mouse button.

**To Clear Cell Contents Using the Shortcut Menu**

1. Select the cell or range of cells to be cleared.
2. Right-click the selection.
3. Click Clear Contents on the shortcut menu.

**To Clear Cell Contents Using the Delete Key**

1. Select the cell or range of cells to be cleared.
2. Press the DELETE key.

**To Clear Cell Contents Using the Clear Command**

1. Select the cell or range of cells to be cleared.
2. Click Edit on the menu bar and then click Clear.
3. Click All on the submenu.

**To Clear the Entire Worksheet**

1. Click the Select All button on the worksheet.
2. Press the DELETE key or on the Edit menu click Clear and then click All on the submenu.

**To Delete an Embedded Chart**

1. Click the chart to select it.
2. Press the delete key.